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Средство разработки CCSv4 базиру-
ется на программном обеспечении 
с открытым исходным кодом Eclipse. 

Использование именно этого продукта обос-
новано тем, что Eclipse обеспечивает превос-
ходную структуру программного обеспече-
ния (ПО), которую поддерживают многие 
продавцы встраиваемых решений. В CCSv4 
совмещаются преимущества Eclipse и луч-
шие решения от TI, что позволяет реализо-
вать удобную и многофункциональную сре-
ду проектирования. На рис. 1 показано глав-
ное окно CCSv4.

Встроенный отладчик адаптируется 
к конкретному типу DSP-процессора, а так-

же умеет выставлять многофункциональ-
ные контрольные точки и работать с ними, 
что значительно облегчает отладку про-
граммного кода. Контрольные точки можно 
привязать к строкам С-кода, локальным пе-
ременным или регистрам. Окно просмотра 
памяти позволяет увидеть каждый ее уро-
вень, что упрощает отладку сложных участ-
ков кода, особенно с использованием кэша. 
Среда CCSv4 поддерживает возможность 
работы с многопроцессорными и много-
ядерными системами. Глобальные конт-
рольные точки и синхронизация операций 
обеспечивают полный контроль над такими 
системами.

Встроенный интерактивный профилиров-
щик помогает быстро определить наиболее 
ресурсоемкие места в коде программы и пра-
вильно распределить производительность 
DSP. Он позволяет легко тестировать про-
изводительность любых C/C++ функций 
в приложении при их циклическом исполь-
зовании, или в других случаях, например, 
при использовании кэша, конвейера, ветв-
лений. При проведении профилирования 
можно выделять диапазоны кода, чтобы по-
лучить более полную информацию о задей-
ствованных ресурсах во время оптимизации 
и отладить код. Для увеличения эффектив-
ности работы возможности профилирова-
ния доступны на любом этапе разработки.

Некоторые задачи, такие как многочасо-
вое или даже многодневное тестирование, 
могут выполняться без участия разработчи-
ка. Для выполнения данных операций сре-
да разработки должна иметь возможность 
их автоматизации. У CCSv4 есть полноцен-
ная скриптовая среда, помогающая созда-
вать и выполнять сценарии для таких задач, 
как сопоставительный анализ и тестирова-
ние производительности. Отдельное окно 
позволяет вводить одиночные скриптовые 
команды или выполнять сценарии в преде-
лах среды разработки.

Среда CCSv4 позволяет проводить анализ 
изображений и графическую визуализацию 
обрабатываемых данных, а также отображать 
данные на мониторе и автоматически их об-
новлять во время выполнения программного 
кода. Кроме того, CCSv4 может показывать 
видео в различных форматах. На рис. 2 пред-
ставлено окно визуализации.

Интегральная среда проектирования Code Composer Studio версии 4 
(CCSv4) предназначена для разработки программного обеспечения 
ко всем процессорам, выпускаемым компанией Texas Instruments 
Incorporated (TI). Среда CCSv4 включает такие инструменты, как редак-
тор исходных текстов, компилятор, линковщик, отладчик, симуляторы 
для всех типов процессоров от TI, средства визуализации и целый ряд 
других вспомогательных инструментов. Это единый графический поль-
зовательский интерфейс, позволяющий производить пошаговую разра-
ботку и отладку программного кода. Интуитивно понятные инструменты 
позволяют разработчикам быстро начать свою собственную разработку, 
постепенно осваивая новые функциональные возможности и улучшая 
производительность своих решений.

Краткий обзор  
отладочной среды 
Code Composer Studio 4

Рис. 1. Основное окно среды разработки Code Composer Studio
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Компиляторы C/C++ от компании TI оп-
тимизируются под конкретный тип процес-
сора таким образом, чтобы максимизировать 
производительность кода. Эти компилято-
ры используют как классические методы 
оптимизации, так и методы, определяемые 
выбранной архитектурой DSP-процессора. 
В частности, оптимизация включает:

упрощение выражений;
программный конвейер;
сокращение выражений;
автоинкрементацию адресов;
распределение регистров;
аппаратные циклы;
“in-lining”-функции;
векторизацию циклов.
Компиляторы TI также могут выполнять 

такую оптимизацию программы, при кото-
рой оценивается эффективность кода на при-
кладном уровне. Программная оптимизация 
позволяет оценить издержки при взаимо-
действии разработанного ПО с той системой, 
куда оно встраивается. Это во многих случа-
ях позволяет увеличить производительность 
системы в целом.

Компиляторы C/C++ для ARM-ядра 
и микроконтроллеров оптимизированы с це-
лью уменьшения размера кода и повышения 
его эффективности. Они являются одним 
из лучших решений по производительности 
и совместимости кода для промышленных 
решений.

Встроенный симулятор позволяет начать 
разработку без наличия реальной отладоч-
ной платы. Кроме того, симулятор обеспечи-
вает широкие возможности по визуализации 
процесса выполнения программного кода. 
Предлагается несколько вариантов симуля-
торов для того, чтобы можно было выбрать 
между точностью оценки кода, скоростью 
анализа и возможностями по моделирова-
нию работы с периферией; одни симуляторы 
являются идеальными для сопоставительно-
го анализа алгоритма, другие — для деталь-
ного моделирования системы.

Во все процессоры TI встроена передовая 
система эмуляции. Она включает:

JTAG-интерфейс (1149.1) и периферийное 
сканирование;

•
•
•
•
•
•
•
•

•

доступ к регистрам и памяти;
режим реального времени, предусматрива-
ющий отладку кода с прерываниями, кото-
рые должны быть разрешены (этот режим 
позволяет приостанавливать выполнение 
второстепенного кода, продолжая выпол-
нять критические прерывания);
многоядерные операции, такие как син-
хронный запуск, отладка по шагам и ос-
тановка;
межъядерный переключатель, который 
обеспечивает запуск одного ядра и оста-
новку другого.
Функциональный менеджер событий 

(Advanced Event Triggering, AET) позво-
ляет останавливать центральный процес-
сор или вызывать другие события, исхо-
дя из некоторых, определенных заранее, 
условий — например, появление недей-
ствительных данных или запрос досту-
па к памяти. Это позволяет более точно 
определить эксплуатационные качества 
программного кода и подсчитывать опре-
деленные системные события (например, 
обращение к кэшу).

Среда CCSv4 поддерживает режим трас-
сировки (Processor Trace), что помогает раз-
работчикам находить «невидимые» до это-
го и трудные для поиска другими методами 
ошибки — состязание событий, «дрожание» 
сигнала в реальном времени, переполне-
ние стека, бесконтрольный код и ложные 
прерывания без остановки процессора. 
Трассировка — это метод для отладки DSP-
процессора без вмешательства и без изме-
нений его поведения в реальном времени. 
Данный режим помогает получить макси-
мальную производительность от програм-
много кода и провести оптимизацию исполь-
зования кэша для многоканальных прило-
жений. Трассировка поддерживает экспорт 
программного кода и данных, тактирование 
и выбор процессора, а также позволяет об-
рабатывать системные события и прерыва-
ния. Режим трассировки поддерживается 
любым внешним JTAG-эмулятором XDS560, 
а на отдельных чипах может сохранять дан-
ные во встроенном трассировочном буфере 
(Embedded Trace Buffer, ETB).

•
•

•

•

Операционная система DSP/BIOS 6.x, по-
ставляемая в составе новой версии CCSv4, 
является современной расширяемой опе-
рационной системой реального времени 
(ОСРВ), которая поддерживает такие ядра, 
как ARM926, ARM Cortex M3, C674x, C64x+, 
C672x и С28x. DSP/BIOS 6.x обеспечивает 
поддержку гораздо более широкого — от-
носительно DSP/BIOS 5.x — списка ядер, га-
рантируя при этом более быстрое и гибкое 
управление памятью, событиями и приори-
тетами. Новая версия ОСРВ обеспечивает 
совместимость с предыдущим поколением 
операционной системы, что помогает легко 
адаптировать прикладное ПО к новой плат-
форме. Операционная система DSP/BIOS 6.x 
является мощным инструментом, который 
позволяет разрабатывать производительный 
код в короткое время. Изучение даже основ-
ных возможностей этой системы выходит 
за рамки данной статьи. Получить более 
детальную информацию можно на сайте 
компании TI [1]. В меню Products выбери-
те раздел Processors, а там — пункт Digital 
Signal Processing. На новой страничке най-
дите пункт DSP Design Support (горизонталь-
ное меню вверху страницы). Затем в разделе 
Tools and Software выберите пункт Operating 
Systems (OS/RTOS) и перейдите на закладку 
DSP/BIOS.

Данная версия CCSv4 уже доступна. 
Существуют несколько вариантов ее постав-
ки. Они представлены на рис. 3.

Выделяются два направления развития 
CCSv4: только для микроконтроллеров  
и для всех процессоров в целом. К микро-
контроллерам относятся семейства MSP430,  
С2000 и Stellaris. Следует отметить, что мик-
роконтроллеры Stellaris построены на базе 
ядра Cortex M3, и их поддержка будет вклю-
чена в CCSv4 в четвертом квартале этого года 
или в первом следующего.

Ограниченная по коду версия для мик-
роконтроллеров позволяет разрабатывать 
прикладное ПО размером не более 32 кбайт 
для процессоров на базе ядра С28х и 16 кбайт 
для MSP430. Кроме того, можно скачать пол-
нофункциональную версию, ограниченную 
по применению. Эта версия работает только 

Рис. 2. Окно визуализации CCSv4 Рис. 3. Варианты поставки CCSv4
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с эмулятором класса XDS100 и не со всеми 
типами процессоров. Демонстрационная 
версия имеет ограничение по сроку исполь-
зования (на данный момент — 120 дней).

Следует отметить, что версия 4 имеет 
и серверный вариант инсталляции. Преду-
смотрена возможность приобретения раз-
личного количества так называемых «пла-
вающих» лицензий, что может быть удобно 
для коллективов программистов.

Стоимость различных вариантов CCS 
на момент написания статьи представлена 
в таблице. Данные взяты с сайта произво-
дителя, поэтому необходимо их уточнение 
у официальных дистрибьюторов.

Для того чтобы загрузить один из бесплат-
ных вариантов CCSv4, необходимо зарегист-
рироваться на сайте TI. Иметь регистрацию 
в любом случае полезно: можно подписаться 
на рассылку новостей, а также скачивать раз-
личную документацию и заказывать бесплат-
ные учебные материалы.

Затем необходимо установить отладочную 
среду. При установке будет предложен ряд 
эмуляторов от различных производителей. 
Рекомендуется ограничиться минимальным 
их количеством, так как если указанного эму-
лятора не будет в системе, может произойти 

«зависание» компьютера. Примерный набор 
эмуляторов, не вызывающий «зависания» 

при установке CCSv4 даже при их отсутствии 
в системе, приведен на рис. 4.

При первом запуске отладочной среды 
появится информационное окно системы 
(рис. 5).

В этом окне, переходя от пункта к пункту, 
можно ознакомиться с основными возмож-
ностями отладочной среды и правилами по-
строения проекта. Чтобы попасть в рабочее 
пространство CCSv4, необходимо закрыть 
информационное окно, щелкнув мышкой 
на крестике в левом верхнем углу (отметка 
красным кружком на рис. 5).

Теперь рассмотрим небольшой пример 
использования CCSv4. Для его реализации 
понадобятся:
1.	Бесплатная версия среды разработки с ог-

раничением на максимальный размер кода 
для микроконтроллеров — TMDFCCS-
MCULTD.

2.	Отладочный комплект TMS320F28335 
Experimenter Kit. Его описание дано в [2]. 
Комплект состоит из базовой платы и мо-
дуля расширения, который вставляется 

Таблица. Стоимость различных вариантов поставки CCS

№  
п/п Код продукта Наименование продукта Стоимость,  

USD Примечание

Поддержка всех семейств процессоров и микроконтроллеров компании TI

1 TMDSCCSALL-1 Code Composer Studio v3.3 1995  С годовой поддержкой

2 TMDSSUBALL Годовая поддержка Code Composer Studio™ 600

3 TMDSCCS-ALLN01 Code Composer Studio IDE v4.0 1995 Одиночная лицензия (N01)

4 TMDSCCS-ALLN01D Code Composer Studio IDE v4.0 1895 Одиночная лицензия (N01D) — без DVD

5 TMDSCCS-ALLF01 Code Composer Studio IDE v4.0 2995 Плавающая лицензия для 1 пользователя (F01)

6 TMDSCCS-ALLF03 Code Composer Studio IDE v4.0 7995 Плавающая лицензия для 3 пользователей (F03)

7 TMDSCCS-ALLF05 Code Composer Studio IDE v4.0 11 495 Плавающая лицензия для 5 пользователей (F05)

8 TMDSCCS-ALLF10 Code Composer Studio IDE v4.0 20 995 Плавающая лицензия для 10 пользователей (F10)

9 TMDSCCS-ALLF25 Code Composer Studio IDE v4.0 44 995 Плавающая лицензия для 25 пользователей (F25)

Поддержка только микроконтроллеров компании TI

1 TMDSCCS2000-1 C2000 Code Composer Studio™ 495  С годовой поддержкой

2 TMDSSUB2000 Годовая поддержка Code Composer Studio™ C2000 495

3 TMDSCCS-MCUN01D Code Composer Studio IDE v4.0 — MCU 445 Одиночная лицензия (N01)

4 TMDSCCS-MCUN01 Code Composer Studio IDE v4.0 — MCU 495 Одиночная лицензия (N01D) — без DVD

5 TMDSCCS-MCUF01 Code Composer Studio IDE v4.0 — MCU 795 Плавающая лицензия для 1 пользователя (F01)

6 TMDSCCS-MCUF03 Code Composer Studio IDE v4.0 — MCU 1995 Плавающая лицензия для 3 пользователей (F03)

7 TMDSCCS-MCUF05 Code Composer Studio IDE v4.0 — MCU 2995 Плавающая лицензия для 5 пользователей (F05)

8 TMDSCCS-MCUF10 Code Composer Studio IDE v4.0 — MCU 5495 Плавающая лицензия для 10 пользователей (F10)

9 TMDSCCS-MCUF25 Code Composer Studio IDE v4.0 — MCU 11 995 Плавающая лицензия для 25 пользователей (F25)

Рис. 4. Минимально необходимый набор компонентов 
при установке CCSv4

Рис. 5. Окно CCSv4 при первом запуске системы

Рис. 6. Отладочный комплект TMS320F28335 Experimenter Kit
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в DIMM-разъем. Причем можно приобре-
тать дополнительные модули расширения 
отдельно, за меньшую стоимость и для раз-
личных типов микроконтроллеров семей-
ства С2000, то есть, приобретя один такой 
комплект, в дальнейшем при необходимос-
ти можно освоить новый тип процессоров 
данного семейства, докупая только модули 
расширения. На рис. 6 показана отладоч-
ная плата с установленным модулем рас-
ширения.
Питание отладочного комплекта осущест-

вляется через USB-интерфейс. Кроме того, 
в базовую плату встроен эмулятор клас-
са XDS100. Отметим, что имеется возмож-
ность подключать как внешний блок пита-
ния, так и дискретный эмулятор. Для этого 
на базовой плате предусмотрены специаль-
ные разъемы. Данная функция может пона-
добиться при макетировании собственных 
устройств на основе стандартного набора. 
Для макетирования предназначено несколько 
рядов металлизированных сквозных отвер-
стий и штыревых разъемов (хорошо видных 
на рис. 6), куда подводятся выводы микро-
контроллера.
3.	Программный пакет с примерами кода 

C2833x/C2823x C/C++ Header Files and 
Peripheral Examples. Скачать его (без регис-
трации) можно по адресу [3]. Загрузите, 
распакуйте и установите его на свой ПК.
При запуске CCSv4 появится диалоговое 

окно с предложением выбрать рабочую об-
ласть (рис. 7). В этой папке будут сохранять-
ся все персональные настройки для CCSv4. 

Также — после выключения CCSv4 — в вы-
бранную папку по умолчанию будут сохра-
няться все настройки разрабатываемых про-
ектов. Например, если до выключения CCSv4 
происходила работа с несколькими проекта-
ми и при этом были открыты окна памяти, 
графики, переменных, то после закрытия все 
настройки сохранятся, а при повторном за-
пуске CCSv4 все восстановится в том виде, 
который был перед закрытием.

Рабочая область автоматически сохраняется 
при закрытии CCSv4. Существует возможность 
работать с несколькими рабочими областями: 
создавать новые и переключаться между уже 
существующими можно через главное меню 
File->Switch Workspace. Рабочая область в рас-
сматриваемой среде не является портативной, 
так как она включает специфические настрой-
ки компьютерной системы. Поэтому нельзя 
сохранить рабочую область, заархивировать 
ее и передать другому пользователю.

Для первого знакомства с возможностями 
CCSv4 будем использовать проект cpu_timer, 
входящий в пакет примеров “C2833x/2823x 
C/C++ Header Files and Peripheral Examples”, 
который к этому моменту должен быть уже 
установлен.

Вначале выберем в главном меню CCSv4 
пункт Project->Import Existing CCS/CCE 
Eclipse Project (рис. 8).

Затем в появившемся окне Import (рис. 9) 
необходимо определить папку проекта — 
Select root directory: нажав кнопку Browse 
и выбрав в стандартном диалоговом окне путь 
<папка установки>/DSP2833x_examples_
ccsv4/cpu_timer, подтвердите выбор кнопкой 
OK. В области Projects окна Import галоч-
кой необходимо отметить проект Example_
2833xCpuTimer. НЕ ОТМЕЧАТЬ пункт Copy 
projects into workspace. Нажать кнопку Finish.

В CCSv4 в области C/C++ Projects (рис. 10) 
должны отобразиться все файлы проекта:

Раздел Binaries — после компиляции 
в этой папке будет находиться бинарный 
исполняемый файл *.out.
Раздел Includes — здесь перечислены все 
директории, ссылки на которые включа-

•

•

ются в опциях компиляции. Дополняется 
список всеми файлами *.h и *.inc, которые 
упоминаются в проекте.
Раздел Debug — содержит все файлы ком-
пиляции, включая *.map и *.obj.
Далее перечисляются все исходные фай-
лы. Если файлы с исходным кодом содер-
жат функции, включают другие файлы 
или структуры, то можно, нажав крестик 
напротив имени файла, увидеть список всех 
входящих в него объектов. Двойным щелч-
ком мыши на имени объекта осуществляется 
переход к тому месту в программном коде, 
где размещены соответствующая функ- 
ция, подключаемый файл или структура.
Следует отметить, что разделы Binaries 

и Debug появляются только после первой ус-
пешной компиляции проекта.

Теперь пришло время настроить парамет-
ры подключения эмулятора к отладочной 
плате. Для этого необходимо выполнить сле-
дующее:

Подключить отладочную плату к компью-
теру при помощи USB-кабеля из комплек-
та поставки. При первом подключении 
платы должно произойти ее автоматичес-
кое распознавание операционной системой 
Windows, так как драйверы для нее устано-
вились при инсталляции CCSv4.

•

•

•

Рис. 7. Определение местоположения рабочей области

Рис. 8. Выбор проекта

Рис. 9. Выбор папки проекта

Рис. 10. Окно C/C++ Projects
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Открыть окно конфигурации подключе-
ния через главное меню CCSv4, выбрав 

• пункт Target->New Target Configuration 
(рис. 11, сноска 1).

Ввести имя файла конфигурации (рис. 11, 
сноска 2). Имя должно иметь суффикс 
.ccxml. Поставить галочку в боксе Use 
default location и нажать Finish.
В появившемся окне выбрать требуемый 
тип эмулятора из выпадающего списка 
Connection. В списке Device отметить нуж-
ный тип процессора. В рассматриваемом 
примере выбраны Texas Instruments 
XDS100 USB Emulator и TMS320F28335 
(рис. 12).
Сохранить настройки подключения, нажав 
кнопку Save в разделе Save Configuration 
(рис. 12). Воспользуйтесь полосой прокрут-
ки внизу окна, если раздел Save Configuration  
виден не целиком.
Посмотреть настройки подключения мож-
но в меню View->Target Configuration.
В разделе User-Defined (рис. 13) показан 
новый конфигурационный файл под-
ключения *.ccxml. Необходимо щелкнуть 
на нем правой кнопкой мыши, а затем вы-
брать пункт Link File to Project->Example_
2833xCpuTimer (для того чтобы всегда ис-
пользовать эту конфигурацию для данно-
го проекта) или пункт Set as Default (если 
необходимо использовать этот эмулятор 
и GEL-файл в качестве настройки под-
ключения по умолчанию для всех откры-
ваемых в будущем проектов, не имеющих 
ассоциируемых с ними файлов конфигу-
рации).
Теперь можно скомпилировать и загрузить 

проект в подключенную отладочную пла-
ту, для чего следует нажать зеленую кнопку 
с изображением «жучка» (Debug) на панели 
быстрых кнопок (рис. 14). При этом про-
изойдут три операции: компиляция проекта, 
подключение к отладочной плате и загрузка 
в нее программного кода.

Операции можно выполнить и поочеред-
но. Компиляция проекта запускается через 
главное меню путем выбора пункта Project-> 
Build Active Project (рис. 15).

Затем выбираем в подменю кнопку с зеле-
ным «жучком» на панели быстрых кнопок 
Launch TI Debugger (рис. 16). После этого 
отладочная среда перейдет в режим Debug, 
и появится окно дизассемблера.

•

•

•

•

•

Рис. 11. Создание новой конфигурации подключения отладочной платы

Рис. 12. Определение типов эмулятора и микроконтроллера

Рис. 13. Подключение файла конфигурации к проекту

Рис. 14. Компиляция, подключение и загрузка проекта

Рис. 15. Компиляция проекта без автоматических подключения и загрузки
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Следующий шаг — это подключение 
CCSv4 к отладочной плате, для чего необхо-
димо выбрать в главном меню пункт Target-> 
Connect Target (рис. 17).

И, наконец, загружаем бинарный код в отла-
дочную плату, выбрав в главном меню пункт 
Target->Load Program и указав в появившем-
ся окне файл Example_2833xCpuTimer.out, 
который находится в директории /cpu_timer/
Debug.

Для повторного запуска проекта требуется 
произвести сброс процессора, выбрав в глав-
ном меню пункт Target->Reset->Reset CPU, 
и, перегрузив программный код, выбрать 
Target->Reload Program.

Отладочная среда CCSv4 позволяет добав-
лять переменные в окно наблюдения (Watch 
Window) и отслеживать их изменения 
при работе программы в реальном времени. 
Для того чтобы добавить переменные в окно 
наблюдения, необходимо:

Нажать значок C/C++ в верхнем правом 
углу экрана для перехода в режим C/C++ 
(рис. 18, сноска 1), перейти на закладку 
с отображением файлов проекта (рис. 18, 
сноска 2) и открыть файл с исходным ко-
дом (рис. 18, сноска 3).
В файле Example_2833xCpuTimer.c в ком-
ментариях найти блок Watch Variables. 
Выделить CpuTimer0.InterruptCount,  
щ е л к н у т ь  п р а в о й  к н о п ко й  м ы ш и 
и во всплывающем меню выбрать Add 
Watch Expressio (рис. 19). Затем повторить 
эти действия для CpuTimer1.InterruptCount 
и CpuTimer2.InterruptCoun. Эти перемен-
ные появятся в окне просмотра (Watch 
Window).
Переключиться в режим Debug, нажав зна-
чок Debug с зеленым «жучком» (рис. 18, 
сноска 1).
Запускаем проект на выполнение, вы-

брав пункт Target->Run (рис. 20, сноска 1). 
Остановить выполнение проекта можно че-
рез пункт Target->Halt (рис. 20, сноска 2). 
К сожалению, эмулятор XDS100 обладает 
ограниченными возможностями по отлад-
ке в реальном времени: он не поддерживает 
функции RTDX, поэтому наблюдать измене-
ние переменных можно только запуская и ос-
танавливая выполнение программного кода.

Если использовать внешний эмулятор 
более высокого класса, например, XSD510, 
то можно реализовать режим отладки в ре-
альном времени. Для этого, во-первых, не-
обходимо разрешить этот режим, выбрав 
в главном меню пункт Tools->Debugger 

•

•

•

Options. В открывшемся окне спуститься 
вниз, до бокса Realtime Options, и отметить 
пункт Enable silicon real-time mode (service 
critical interrupts when halted, allow debugger 

accesses while running) (рис. 21). Затем в по-
явившемся окне выбрать “Yes” для под-
тверждения переключения в режим реально-
го времени.

Рис. 16. Перевод отладочной среды CCSv4 в режим отладки Рис. 17. Подключение к отладочной плате

Рис. 18. Переключение CCSv4 между режимами “Debug” и “C/C++”

Рис. 19. Добавление переменных в окно наблюдения

Рис. 20. Запуск и остановка выполнения программного кода

ЦСП



96

КОМПОНЕНТЫ И ТЕХНОЛОГИИ • № 12 '2009

компоненты

Во-вторых, в верхнем правом углу окна 
просмотра (Watch Window) нажать бе-
лую стрелку и выбрать пункт Customize 
Continuous Refresh Interval…. В появившемся 
окне изменить значение интервала обнов-
ления на «1» (секунду) вместо «5» (секунд) 
по умолчанию. Процесс показан на рис. 22.

В-третьих, для того чтобы разрешить ре-
жим непрерывного обновления, в верхнем 
правом углу окна просмотра переменных не-
обходимо нажать на желтую иконку с изоб-
ражением вращающихся вокруг знака пау-
зы стрелок (рис. 23, сноска 1): наблюдаемые 
переменные будут постоянно обновляться 
в реальном времени до тех пор, пока выпол-
няется программа.

И последнее: запуск программы. Для этого 
выберите иконку в виде зеленого треугольни-
ка на панели быстрых кнопок (рис. 23, снос-
ка 2), или в главном меню пункт Target->Run, 
как это уже было показано на рис. 20, сноска 1.

Наблюдаемые переменные в окне про-
смотра будут инкрементироваться один раз 
в секунду в соответствии с прерываниями 
таймера ЦПУ (рис. 24).

На этом краткий обзор новой отладочной 
среды компании Texas Instruments закончен. n
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Рис. 21. Разрешение режима реального времени для мониторинга переменных Рис. 24. Инкрементация значения переменных в окне просмотра

Рис. 22. Изменение интервала мониторинга переменных

Рис. 23. Запуск проекта в режиме отладки в непрерывном времени
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